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Estimated time to complete lab is 60 minutes 

 

To perform the last exercise of this lab where you will publish a 

database project to a Microsoft Azure SQL Database, you will require a 

Microsoft Azure account. 

If you do not have an Azure account, you can request a free trial 

version by going to http://azure.microsoft.com/en-us/pricing/free-

trial/.  

Within the one-month trial version, you can perform other SQL Server 

2014 hands on labs along with other tutorials available on Azure.  

Note, to sign up for a free trial, you will need a mobile device that can 

receive text messages and a valid credit card. 

You can still perform this hands on lab without an Azure account with 

the exception of the last exercise. 

Be sure to follow the Roll Back Azure changes section at the end of this 

exercise after creating the Azure database so that you can make the 

most use of your $200 free Azure credit. 

 

As organizations are focused on becoming more effective, doing more 

with the same amount or less resource and striving to become more 

agile in deploying and improving applications, it becomes important to 

manage the skills and future skills requirements of your staff or to 

provision new tools. Unfortunately both these options can require a 

significant amount of continuing investment, as well as a delay in 

realizing that investment as people get up to speed and practiced in 

deploying the tools they have been given or the skills they have been 

taught. Improvements in the integration between the traditional SQL 

Server Management Studio capabilities and Visual Studio mean that 

organizations can now work with familiar toolsets and environments 

but allow DBAs to reduce the time required to modify, test and publish 

solutions within or across different versions of SQL server, as well as 

improve on best practice by storing all the database components in 

source safe allowing for version control and auditing. This means 

organizations can achieve a significant increase in efficiency without 

having to invest in tools or training and minimize their time to their 

realization of this efficiency gain. 

 

Azure 
account 
required for 
last exercise 

Optimized 
productivity– 
One set of 
tools for 
everything 

http://azure.microsoft.com/en-us/pricing/free-trial/
http://azure.microsoft.com/en-us/pricing/free-trial/
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The  new release of the SQL Server Data Tools to support SQL Server 

2014 enables you to support both database and business intelligence 

projects. From the BI standpoint, this will provide you with a tool to 

manage SSAS and SSRS project for SQL Server versions 2014 and lower 

and SSIS for SQL 2014 only. When looking at databases, the full 

integration with the Visual Studio SKUs allows you to provide end-to-

end support for building and managing Windows Azure SQL 

Databases and SQL Server databases. In this lab, you will run and 

explore this tool. 

NOTE: SQL Server Data Tools has been split into two products – SSDT 

and SSDTBI. SSDT is for working with database projects and is a stand-

alone tool if Visual Studio is not installed. Comparatively, SSDTBI is for 

business intelligence project (SSAS, SSIS, SSRS.) Both are installed pn the 

lab environment,, so now can work with database project, BI projects, 

and development projects from the one interface of Visual Studio 2013. 

Here, you will be exploring the BI capabilities, and will use the database 

capabilities in the next scenario. 

Connect to SQLONE computer 

1. Click on SQLONE button on right side of the screen to connect 

to the SQLONE computer. If you see the following in the lower 

right corner of the screen, you can jump to step 5 below to set 

your screen resolution. 

 

2. Click Send Ctrl-Alt-Del for SQLONE computer and then click 

Switch user. 

3. Click Send Ctrl-Alt-Del for SQLONE computer again and then 

click Other user. 

Using SSIS 
project to 
export a 
table to a 
flat file 
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4. Log on to SQLONE computer as labuser with password 

pass@word1 

Note, if you have a monitor that supports a larger screen resolution than 

1024 x 768, you can change the screen resolution for the lab to go as 

high as 1920 x 1080. By going to a higher screen resolution, it will be 

easier to use SQL Server Management Studio. 

5. Right click on the desktop and click on Screen resolution. 

6. Select 1366 x 786 (a good minimum screen size for using 

SSMS) and click OK. 

7. Click Keep Changes. 

8. Resize the client holLaunchPad Online window for the lab to 

fit your screen resolution. 

Create an SSIS project 

1. Open SQL Server Data Tools for Visual Studio 2013 from the 

start screen 

 

2. On the File menu, click New > Project 

3. In the New Project wizard, select the Business Intelligence 

template type (in the left hand pane) then select an 

Integration Services Project (in the center pane.) 

4. Enter ContosoRetailDWPackage as the name for the project 

Note how the solution name automatically changes as you change the 

solution name 
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5. Select the location of the project as C:\SQLPROGRAMS\E4 

6. Ensure Create a directory for the solution is checked and 

Add to source control is not 

You will be exploring source control later in this story 

 

7. Click OK to create the project 

Create an SSIS connection to ControlsRetailDW 

1. Right-click in the Connection Managers pane at the window 

bottom and select New OLE DB Connection… 
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2. In the popup box, click New… 

 

3. Enter SQLONE as the Server name, select Use Windows 

Authentication, and select ContosoRetailDW as the database  
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4. Click OK to create the data source, then OK to create the 

connection manager 
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Add a data flow task 

1. Drag a Data Flow Task control from the SSIS Toolbox onto 

the central pane 

 

2. Double-click on the newly-created Data Flow Task in the 

central pane. This opens the Data Flow task 

3. Drag an OLE DB Source control from the SSIS Toolbox (under 

Other Sources) onto the central pane 
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4. Click once on the text OLE DB Source of the new control, type 

DimProduct Source and press ENTER to change the control 

name 

 

Select the table to use as the source 

1. Double-click on the DimProduct Source control to open its 

editor 

2. The OLE DB connection manager property will automatically be 

assigned to the SQLONE connection manager you created 

earlier 

3. Select DimProduct from the Name of the table or the view 

dropdown box, then click OK. 
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Add a destination and connect it to the data source 

1. Drag a Flat File Destination control from the SSIS Toolbox 

(under Other Destinations)  onto the central pane 

 

2. Click on DimProduct Source again 

3. Once the blue arrow coming out the bottom of the 

DimProduct Source is visible, drag it so the bottom end is on 

top of the Flat File Destination control 
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4. Double click on the Flat File Destination control to open its 

editor 

5. In the editor, click New… next to the Flat File connection 

manager dropdown box 

 

6. Select Delimited as the Flat File Format and click OK 
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7. Click on Browse next to the File name box to select a file. 

 

8. In the Open dialog, navigate to C:\SQLFILES, enter SSISTest as 

the file name, and then click Open to choose the new file. 
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9. Look at Columns tab in the left to see what columns the new 

flat file will have 
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10. Click OK to create the connection manager 

11. Go to the Mappings page of the Flat File Destination Editor 

window, and note that all columns in the Available Input 

Columns box have a line going from them to a column of the 

same name in the Available Destinations columns 
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12. Click OK 

Run the package in debug mode 

1. Click  Start icon in the command bar at the window top 

2. Watch the green tick appear on DimProduct Source and then 

on Flat File Destination showing the source and destination 

were both successful 
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3. Once the package execution has completed with success, open 

File Explorer, navigate to C:\SQLFILES, and open SSISTest.txt. 

You should see all the data from DimProduct in this text file. 

 

4. Click on the stop icon  in the command bar at the window 

top 

5. Close SQL Server Development Tools for Visual Studio 2013 

after saving the project 

You just learned how to create an SSIS project from within Visual 

Studio 2013 to copy data from one of his database tables into a text 

file. 
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Visual Studio 2013 provides an integrated toolset for utilizing BI and 

database capability. It allows user to reverse engineer database 

solution from actual database and provides the ability to maintain and 

manage various versions of the database 

In this exercise, you will use SQL Server Development Tools for Visual 

Studio 2013 to explore the tools to ensure that you can access, 

configure and run the components that relate to DBA development 

tasks. You will begin by looking into managing and developing 

schemas. 

SQL Server Development Tools for Visual Studio 2013 provides a rich 

development environment outside of SQL Server Management studio 

that allows you to take advantage of a number of features that could 

improve the performance of the DBA team when making changes to 

schemas and tables. The capabilities offered by SQL Server Data Tools 

will allow you to do this.  

Initial Cleanup 

In Windows Explorer navigate to C:\SQLPROGRAMS\E4. 

Delete the ContosoRetailProj folder. 

 

Connect to a SQL 2014 Database from Visual Studio 2013 

1. Open SQL Server Development Tools for Visual Studio 2013 

from Windows Start 

2. Select SQL Server Object Explorer from View menu 

 

3. In the SQL Server Object Explorer, right click on SQL Server 

and select Add SQL Server... option. Alternatively, click on 

Add SQL Server icon available on the SQL Server Object 

Explorer tab. 

4. Enter SQLONE as the Server name 

5. Select Windows Authentication  

Managing 
and 
developing 
schemas 
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6. Click on Connect 

7. In the SQL Server Object Explorer, a node for SQLONE will 

now appear under the SQL Server node. Expand this node, 

then expand Databases folder to view all databases available in 

SQL Server 2014 

 

Create a project from the ContosoRetailExportable database 

1. Right click on ContosoRetailExportable and select Create 

New project... 
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2. In the Create New Project – Import Database wizard, change 

the Target project name to be ContosoRetailProj and the 

location to read C:\SQLPROGRAMS\E4, ensure Create new 

solution and Create directory for solution are both ticked, 

and Add to source control is not. 

3. In the Import Settings section, check all the options listed 

 

4. Click Start to create the project. Click OK to overwrite if the 

message box appears. 

5. Progress and summary of the import is shown as the last step. 

Note, it may take some time to enter the Summary page. 
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6. Click on Finish to exit the wizard 

7. Click View -> Solution Explorer and expand the dbo and 

Tables folders. 
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NOTE: The database objects are grouped by the Schema, so all objects in 

this database will be grouped under dbo 

Browse and modify tables in Design Mode: 

SQL Server Data Tools uses a local copy of the database, so any changes 

you make to the tables will not affect the underlying, live databases until 

you  publish them. 

1. In the Solution Explorer, right-click on the Dim Currency.sql 

table and select View Designer to view the table schema in the 

table designer.  
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Alternatively, you can double click on table to open the table in design 

mode. 

2. Check the Allow Nulls box for CurrencyLabel column. Notice 

how the corresponding code in the script pane is changed to 

NULL immediately. 

 

3. Similarly, any change to the T-SQL will be reflected in the 

designer 

Design Mode allows for complicated and involved changes to be made 

intuitively, as any effects of the change are visible immediately. 

4. Save the change by clicking on Save  icon from the toolbar. 
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Change to a database object automatically updates related items 

in the model 

The Dim_Currency table is referenced by Fact_OnlineSales via a 

foreign key on the CurrencyKey column. In this example, you will see 

how SSDT refactors the model when changing the primary key column 

name in the Dim_Currency table. 

1. Go to the Dim Currencty.sql [Design] editor and select the 

CurrencyKey column in the table by clicking on the row 

selector. 

 

2. SQL -> Refactor -> Rename 

 

3. Rename [CurrencyKey] to [CurrencyId] by selecting the value 

in the design view, changing it, and pressing OK. 

 

4. The Preview Changes – Rename dialog allows you to see the 

impact of the column rename operation. 
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5. After examining the changes, click Apply. 

6. Notice that SSDT added a ContosoRetailProj.refactorlog to 

the project in the Solution Explorer.  
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7. Single-click on the ContosoRetailProj.refactorlog file to view 

its contents. 

 

8. Save the changes made to the table by clicking on Save  

icon from the tool bar. Alternatively, right click on the current 

tab and select Save table option. 

9. From the Solution Explorer pane, double click on 

FactOnlineSales.sql  

10. In the T-SQL pane in the central pane, scroll down to note that 

the foreign key in the table definition now refers to CurrencyId 

rather than CurrencyKey – this change happened 

automatically when you changed the DimCurrency table. 
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This makes it extremely simple to make complex and involved changes 

to the model. This allows you to use some of the very useful features of 

Visual Studio Integrated toolset, extract the database to create 

solutions using the database, which can be added to version control, 

and also opens a whole world of options for you to develop, manage 

and deploy the database to various environments. 

Deploy changes to a local sandbox database 

You can see how your changes affect the database and if they cause 

any errors without deploying the changes to the main database 

running on SQLONE. You will deploy to the sandbox copy of the 

database that Visual Studio made when importing the SQLONE 

database into the project. 

1. Right click on the project ContosoRetailProj from the 

Solution Explorer pane and click on Build to make sure there 

are no errors/issue in the project 
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2. If there are any build errors, correct the errors before 

proceeding  

 

3. Click on  Start icon from the toolbar 

This deploys the changes to a local sandbox database 

(localdb)\ProjectsV12 which can be located under SQL Server node in 

the SQL server Object Explorer pane 

4. Expand the Databases node under the (localdb)\ProjectsV12  

5. Right click on the ContosoRetailProj node and click Refresh 
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6. Expand FactOnlineSales and then expand Keys 

7. Click on FK_FactOnlineSales_DimCurrency. Note how the 

properties for this foreign key relationship is shown in the 

Properties window on the right. Note the Referenced Key 

Columns to see how it has changed to CurrencyID reflecting 

the changes made in the refactor operation. 

 

8. If you want to see the code change for the key, go back to the 

SQL Server Object Explorer and double-click on the 

FK_FactOnlineSales_DimCurrency key. 

Notice that SSDT highlights the line of code in the editor that defines the 

foreign key constraint. 
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9. Exit Visual Studio 2013 after saving the project 

Above stated feature allows you to work on a local isolated copy of the 

database to create, test and deploy the changes before affecting a live 

environment. He can later deploy these changes back to the production 

database, if he desires. 

You can see how using the SQL Server Data Tools and their increased 

integration and functionality with Visual Studio, the DBA’s can save time 

and effort when changing schemas and administering the database. The 

ability to be able to review the changes and save the scripts that are 

generated will also save time and rework if he wants to deploy them into 

a live environment knowing that he has already been able to test the 

changes on a local copy knowing that the changes will work. 

 

DBA’s can benefit from having a more robust change, development 

and code repository to use when altering the databases, much in the 

same way developers do when writing code. By taking advantage of 

the integration between SQL Server and Visual Studio as well as the 

functionality and benefits offered by Team Foundation Server 

(TFS)/Git, You can now version and snapshot all the changes to the 

database as well as script changes, and store these in a source safe 

repository. Once you have your changes committed and the code 

saved, you will use SQL Server Data Tools to publish the new database 

back to SQL 2014 Server. 

SQL Server Data Tools to allow you to adjust the target of where you 

wish to publish the data to. This is particularly useful when moving 

databases from different versions of SQL Server up to Windows Azure 

or if people in the team have made changes to the database that aren’t 

compatible with Windows Azure. You can use this tool to quickly test 

and correct other people’s modifications as required as you deploy to 

other platforms. 

Create the Repository 

Source code 
control using 
Git Remote 
Repository 
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You will use Git version control (an open-source form of version control 

more focused on flexibility.) Once you have completed this step, use 

that form of version control throughout the scenario.  

Setting up Git Remote Repository 

1. Right click on the PowerShell icon on the toolbar and click 

Run ISE as Administrator. Click Yes for the User Access 

Control dialog. 

 

2. Press Ctrl+O to open a file, navigate to C:\SQLSCRIPTS\E4\ 

and select the script E4D-3#1-Remove existing Git remote 

repository.ps1. Click Open. 

This script deletes the existing Git remote repository  

 

3. Press F5 to execute the statement. 

4. Press Ctrl+O and select the script E4D-3#2-Create Git remote 

repository.ps1’ and press Open. 

This creates and initializes the Git remote repository at 

C:\SQLPROGRAMS\E4\GitRemote. Note, a Git remote repository can 

also be hosted online at Github.com, rather than on your local machine 

as is being shown here. 



 

Exploring SQL Server Data Tools in Visual Studio 2013 32 

5. Press F5 to execute the script. 

 

6. Close the Windows PowerShell ISE program. 

Checking a database project into source control server 

Git allows version controlling and shared access to the database 

project. To add your project solution to a version control server, follow 

the steps below: 

1. Open Visual Studio 2013 

2. Press Ctrl+Shift_O to open a Project/Solution 

3. From the Open Project window double click 

ContosoRetailProj folder, select the file 

ContosoRetailProj.sln then click Open. This will open 

the Solution Explorer as a pane on the right hand side.   

 

If not then from the View menu, select Solution Explorer    

4. On the File menu, click Add to Source Control.  Alternatively, 

right click on the project solution and click on (Source Control 
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>) Add Solution to Source Control. (The bracketed sections 

will only be present if you are using a TFS server.) 

 

5. Choose Source control dialog appears 

6. Select one of the Git option and click on OK  

 

NOTE: Team Foundation Version Control option uses a single 

centralized server repository to track and version files. Local changes are 

always checked in to the central server where other developers latest 

changes. Git option could be used to enable distributed version control 

system that uses a local repository to track and version files. Changes 

are shared with other developers by pulling changes through a remote, 

shared repository. 

7. Go to Solution Explorer pane 
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8. Right click on the solution and click on  Commit… icon (may 

be within Source Control menu) 

 

9. The Team Explorer – Changes pane will be displayed, the list 

of changes are listed 
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NOTE: If “Configure your user name and email address before 

committing changes” message is shown on top of the Team Explorer – 

Changes pane, click on Configure link in the message. Provide your user 

name, email address and click on Update. 

Commit changes 

1. Review the list of changes and type a commit message (e.g. 

Original Version) to help while trying to retrieve a version of 

code at a later point of time  
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2. Click Commit 

NOTE: Committing the project stores the new version on your local 

machine until you push it onto the server 

 

3. Click on Sync link from the message on the top of the Team 

Explorer bar 

 

4. Provide the Git URL as C:\SQLPROGRAMS\E4\GitRemote and 

click on Publish 
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In the Team Explorer a message will be displayed to inform you that 

the origin remote has been created a current branch has been published 

If you need to sync the local branch with the remote branch master click 

on the Sync button.   

 

In the Team Explorer a message will then be displayed to confirm that 

commits have been synchronized. 
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Retrieve/Pull committed changes from Git 

Git is designed for collaborative work across a team, so this option is to 

get work committed by other team members. 

1. Ensure that Team Explorer is open at the Unsynced Commits 

view.  

If it is not already then click on the Home icon   then click on 

Unsynched Commits  
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2. If this project had another team member who had committed 

work since you last updated your local repository, their recent 

commits would be listed under Incoming Commits. You 

would select the commit you wanted to look at and click fetch 

(to preview the effect of the changes before integrating them 

into your work) or pull (to merge the commit with your local 

version.) 

Modify Database Objects and check-in 

1. Open Solution Explorer to view all the SQL objects available in 

the project 

2. Expand the project node, followed by dbo and Tables node 

3. Double-click on DimCurrency.sql to open it in design mode 

 

4. Add a new non null [IsActive] column of type [Bit] and default it 

to have a value of 1. You can either do this by clicking in the 
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blank line under CurrencyDescription in the design section 

and entering the values, or by adding a new line in the CREATE 

TABLE script in the T-SQL view between the 

[CurrencyDescription] line and the first CONSTRAINT line to 

read [IsActive] BIT NOT NULL DEFAULT (1), 

 

Either of these methods will cause the other view to automatically 

update. 

By default, modifying the object definition automatically checks out file 

containing the definition from version control (creates a local copy of 

this file that you can change and then later check in to version control 

server if desired.) 

5. On the File menu, click Save DimCurrency.sql to save the 

changes (on the local file.)  

6. Add a new view by right clicking on the schema dbo in the 

Solution Explorer and clicking on Add and View…  

 

7. Enter the view name DateView and click on Add  
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8. This opens a sql script for Creating a new view 

9. Replace the table name [SomeTableOrView] in the from clause 

with [Dim Date] and click on Save  icon  from the toolbar 

 

10. Right-click on the project ( ) in the Solution 

Explorer pane and select Source Control > Commit… 

11. Enter a comment to describe the change (e.g. New column 

[IsActive] added to <your table> table and new view <your 

view> added)  
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12. Click on Commit And Push (drop down option from the 

Commit button) if using Git. Click Yes if prompted to confirm 

save. 

 

This saves a version of the database object which could be retrieved later 

from the Get repository. The changes checked in are also now available 

to other team members to view/use. 

Create a database snapshot using Git 
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A Database snapshot captures a copy of the database project as it 

exists at the time you take the snapshot.  

1. In Visual Studio Solution Explorer, right click on the project 

you want to create a snapshot for and choose Snapshot 

Project. 

 

2. A <your project>_<timestamp>.dacpac file is created under 

a folder named Snapshots in the project 

 

3. Check In the snapshot by right clicking on it and selecting 

Commit as after modifying database objects. 



 

Exploring SQL Server Data Tools in Visual Studio 2013 44 

 

The snapshot(s) created could be used to create new database project 

with the state of objects present at the time of creating the snapshot. 

These snapshots could also be used to compare the database schema 

created between two snapshots or live databases or projects. The 

compare schema also provides an option to generate the script to be 

used to move between two versions of the database.  

Compare Snapshots 

1. Rright-click on the project in the solution explorer and select 

Schema Compare…,  

2. Once the SqlSchemaCompare tab has opened, click the drop-

down arrow next to the source, choose Select Source… 

 

3. In the Select Data-tier Application File dialog, navigate to the 

path 

C:\SQLPROGRAMS\E4\ContosoRetailProj\ContosoRetailPr

oj\Snapshots directory and then select the <your 

project>_<timestamp>.dacpac file and click Open. 
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4. In the SqlSchemaCompare tab, source is set to the snapshot 

selected. 

5. Click OK for the Select Source Schema dialog. 

 

6. Click on Select Target… option from the target dropdown  

7. Select the Database option and choose the 

SQLONE.ContosoRetailExportable (contoso\labuser) 

database from which this solution was created 
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NOTE: You could also select the project or one of the previously created 

snapshots to compare the schema against 

8. Click on  Compare from the menu bar of the current tab 

9. Results window shows the list of addition(s) and deletion(s) 

performed between the version and Object Definitions 

window highlights the changes between the version 

 

10. Click on  in the menu bar (tooltip is Generate Script) from 

the menu to create the script to run against the source 

database to get to the target state 

Do not run this script, as we do not want to change the source 

database in this case. 
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This feature enables you to browse through the schema differences 

visually before deployment. It also helps you in generating the delta SQL 

script to move between versions (if needed). 

Preparing to Publish the Database Project to a Live Database 

Before building/publishing the changes to any server, let us look at 

some of Project Properties which can be used to make Publishing to 

different environments quite simple.  

1. Right click on the project and select Properties from the 

Solution Explorer 

2. In the Project Settings tab, you could set the version and type 

of SQL server you want to publish the current solution to, which 

could be SQL Server 2005/2008/2012/2014 or Windows Azure 

SQL Database. Here, verify the Target platform is SQL Server 

2014 
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NOTE: When one of the SQL servers are selected, errors specific to that 

version of the SQL server are highlighted during Build 

3. In the Build tab, you could check the Treat Transact-SQL 

warnings as errors option. This would highlight the Transact-

SQL warnings as error while building the project. Do not check 

this option here. 

 

NOTE: You could also suppress any Transact-SQL warnings you do not 

want to be shown as errors 

4. In the SQLCMD Variables tab, you could define the values for 

system defined variables and/or user defined variables like 

$DatabaseName, $DefaultDataPath, etc. These variable values 

could be used to provide dynamic substitution for debugging 

or publishing to various environments and servers. Do not 

change anything on this page now. 
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5. Build Events tab could be used to specify a command line to 

execute before the build operation starts and a command line 

to execute after the build operation has completed. Do not 

alter this settings page now. 

 

6. You can use options from Code Analysis tab to discover 

potential issues in your scripts, such as design, naming and 

performance problems. Rules for database projects are 

organized into predefined rule sets that target specific areas, 

and you can enable or disable any of the rules available. 

 

Rebuild and debug issues 

7. In the Code Analysis tab of the project properties, check the 

Enable Code Analysis on Build option 
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8. Check Treat Warning as Error check box against 

Microsoft.Rules.Data.Design entry  

 

9. Click  in the menu bar to save the changes 

10. Right click on your project from the Solution Explorer pane 

and click on Rebuild  

11. Go to Error List pane to view the list of errors 

 

12. In the Error List pane, double click on the error with the prefix 

“SR0001 : Microsoft.Rules.Data :”  

This will take you to the view definition window with asterisks (*) 

highlighted.  

13. Rright click on asterisks and select Refactor and Expand 

Wildcards… option.  
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14. In the preview changes window, click on Apply. 

 

15. Click on Save from the tool bar to save the changes made to 

the View 

16. Right click on your project from the Solution Explorer pane 

and click on Rebuild  

17. If there are any other build errors, correct the errors before 

proceeding, eg by changing NVARCHAR(1) to NCHAR(1) in 

necessary table definitions 
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NOTE: To deploy a database into Window Azure, all tables present in the 

database should have a clustered index. Error SQL71560 (Table does not 

have a clustered index. Clustered indexes are required for inserting data 

in this version of SQL Server) could be eliminated by creating a clustered 

index for the table specified. 

Commit changes to Git 

1. Right click on the project and click on Commit. 

2. Enter a comment and click on Commit and Push. 

 

3. Verify the commit action was successful. 
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Publish the Database to SQL Server 2014 instance 

1. Right click on the project and select Properties 

2. Go to Project Settings tab and ensure that the Target 

platform is set to SQL Server 2014 

 

3. Right click on the Project from the Solution Explorer pane and 

click on Publish... 

 

4. Click on Edit... to open the Connection Properties dialog box 
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5. Enter SQLONE as the Server name, select Use Windows 

Authentication  

6. Enter ContosoRetailProj_2 as the database name 

We are deploying to a new database here. You could 

alternatively deploy to an existing database 

 

7. Click OK 

8. If needed, alter the publish script name in the text box below 

9. Click on Advanced... button to set other Publishing properties 

available 
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NOTE: One of the options which is checked by default is Block 

incremental deployment if data loss might occur. When this option 

is checked, any action which could cause a possible data loss in the 

target database will be stopped and the deployment will fail. If you are 

sure about the data loss and want the change(s) to be deployed, uncheck 

this option and click on OK. 

 

10. Click on Save Profile As button to save the settings selected 

(including the options selected in the advanced publish 

settings) 
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11. Browse to a desired location, provide a profile name and click 

on Save 

 

12. Click on Generate Script to generate a SQL script to publish 

the changes on the desired target server 

This also helps in generating the deployment scripts which could be re-

used for deploying to different environments 
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13. Click on  in the menu bar to publish the changes to target 

server 

 

14. To verify the changes, open the SQL Server Object Explorer 

pane (from the menu select View then SQL Server Object 

Explorer), expand SQL Server then SQLONE then Databases 

and you should see ContosoRetailProj_2 
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NOTE: If the database is not shown then press the refresh icon  you 

will need to repeat the expand steps above  

15. Expand the Server and the Database folder 

16. Locate the database to which the changes were deployed and 

expand ContosoRetailProj_2 followed by the database object 

folder (e.g. Tables, View, etc.) 

17. Double-click on any database object (eg the dbo.Dim Currency 

table) to open it in design view and see  

 

Visual Studio 2013 gives you a single interface to manage the end to 

end development of an application. It provides the ability the have a 

fully managed development process and source safe repository. Also 

helps you in managing the entire life cycle in a better and efficient way. 
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This feature allows DBA’s to work more effectively and have a source 

safe repository for all their code, code changes and model changes 

allowing them to easily develop solutions and enhancements and 

publish these changes from a single toolset. This makes collaboration 

more effective and saves the team time and effort. 

 

Create the target Azure SQL Database 

1. If you are not already in Azure Management Portal, open 

Internet Explorer from the start screen and browse to 

https://manage.windowsazure.com/ then sign in using your 

Azure credentials. 

2. In the blue navigation bar, click on SQL DATABASES. 

3. In the grey options bar, click +New. 

 

4. Select Custom Create. 

5. Enter a name for the database as ContosoRetailProj and select 

your subscription if asked. 

6. Select SQL_Latin1_General_CP1_CI-AS as the collation. 

7. Choose New SQL database server as the Server and click the 

next arrow. 

You can now close the lab environment. 

Publish 
project to 
Azure SQL 
Database 

https://manage.windowsazure.com/
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8. Enter a LOGIN NAME as AzureAdmin and LOGIN 

PASSWORD as Pass@word12 

These define an SQL user which will initially be the only user who can 

access the database, and is not the same as your Azure login. You can 

create other SQL users later if desired (not covered in this tutorial.) 

9. Choose West US as the region, leave Allow Windows Azure 

Services to Access the Server ticked, and click the check mark 

to create the database. 
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10. Copy the generated server name to the clipboard by selecting 

the name in the list and pressing Ctrl+C. 

 

You now need to open a firewall port on the Azure SQL Database so you 

can connect using your computer’s IP address. 

11. Click on the database name you created to display the 

database overview page. 
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12. Click on the Set up Windows Azure firewall rules for this IP 

address link. 

13. Click Yes to respond to the prompt to update the firewall rules. 

Publish the Database to Azure SQL Database: 

1. Right click on the project in the Solution Explorer and select 

Properties 

2. Go to Project Settings tab and ensure that the Target 

platform is set to Windows Azure SQL Database 

 

3. Click File > Save Selected in the menu or us CTL-S (press Ctrl 

key and S key down at the same time) 

4. Right click on the project from Solution Explorer pane and 

click on Build 

5. Open the Error List pane at the bottom of the window.  

Any problems for deploying to Azure will be displayed here. 
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6. If there are any errors, double-click on them to go to the 

location of the error and then fix it. You can ignore warnings. 

NOTE: To deploy a database into Window Azure, all tables present in the 

database should have a clustered index. Error SQL71560 (Table does not 

have a clustered index. Clustered indexes are required for inserting data 

in this version of SQL Server) could be eliminated by creating a clustered 

index for the table specified in the list. 

7. Right click on the Project from the Solution Explorer pane and 

click on Publish... 

 

8. Click on Edit... to open the Connection Properties dialog box 

9. Enter the Windows Azure SQL Server name, by pasting the 

server name followed by database.windows.net 

Example: n04vaq4nef.database.windows.net 

10.  Select Use SQL Server Authentication  

11. Enter the User name as AzureAdmin and Password as 

Pass@word12 to connect to the server 

12. Enter ContosoRetailProj as the database name 
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13. Click Test Connection to make sure you have the server 

connection information correct and the OK to dismiss the 

message box. 

14. Click on OK  

15. Change the publish script name to 

ContosoRetailProjAzure.sql 
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16. Click Publish to publish the changes directly. 

NOTE: This may take a significant amount of time to process 

Generating a script also helps in generating the deployment scripts 

which could be re-used for deploying to different environments 

17. To verify the changes, right click on the Windows Azure SQL 

Server/Database in the SQL Server Object Explorer pane and 

click on Refresh. 

18. Expand the Server and the Database folder 

 

19. Locate the database to which the changes were deployed and 

expand the database followed by the database object folder 

(e.g. Tables, View, etc.) 

20. Double click on the View dbo.DataView to open the designer 

and verify the published changes 
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Visual Studio 2013 gives you a single interface to handle modification 

and publication with no intermediate steps. It saves a lot of time which 

is spent on integrating independent changes and different versions of 

development. You now have one go to tool to handle all your 

development and deployment needs. With Visual Studio 2013 it has 

become more agile to deploying and manage changes and 

applications between platforms. 

 

Rollback Azure changes 

1. Open the Azure Management Portal at 

https://manage.windowsazure.com/ and sign in with your 

credentials  

2. Delete Azure databases and servers 

i. Click on SQL DATABASES in the navigation pane 

ii. Click SERVERS at the page top and select the server you 

want to delete (if you are not sure which server you created 

during this experience, click on the server name then 

Databases at the top of the page to see a list of databases 

hosted on this server.) 

iii. Click DELETE in the options pane at the bottom of the page 

iv. Carry out the confirmation steps and click the check mark. 

You can now close this lab. 

Roll back 
Azure 
changes 

https://manage.windowsazure.com/
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© 2014 Microsoft Corporation. All rights reserved. 

By using this Hands-on Lab, you agree to the following terms: 

The technology/functionality described in this Hands-on Lab is 

provided by Microsoft Corporation in a “sandbox” testing environment 

for purposes of obtaining your feedback and to provide you with a 

learning experience. You may only use the Hands-on Lab to evaluate 

such technology features and functionality and provide feedback to 

Microsoft.  You may not use it for any other purpose. You may not 

modify, copy, distribute, transmit, display, perform, reproduce, publish, 

license, create derivative works from, transfer, or sell this Hands-on Lab 

or any portion thereof. 

COPYING OR REPRODUCTION OF THE HANDS-ON LAB (OR ANY 

PORTION OF IT) TO ANY OTHER SERVER OR LOCATION FOR FURTHER 

REPRODUCTION OR REDISTRIBUTION IS EXPRESSLY PROHIBITED. 

THIS HANDS-ONLAB PROVIDES CERTAIN SOFTWARE 

TECHNOLOGY/PRODUCT FEATURES AND FUNCTIONALITY, 

INCLUDING POTENTIAL NEW FEATURES AND CONCEPTS, IN A 

SIMULATED ENVIRONMENT WITHOUT COMPLEX SET-UP OR 

INSTALLATION FOR THE PURPOSE DESCRIBED ABOVE.  THE 

TECHNOLOGY/CONCEPTS REPRESENTED IN THIS HANDS-ON LAB 

MAY NOT REPRESENT FULL FEATURE FUNCTIONALITY AND MAY NOT 

WORK THE WAY A FINAL VERSION MAY WORK.  WE ALSO MAY NOT 

RELEASE A FINAL VERSION OF SUCH FEATURES OR CONCEPTS.  YOUR 

EXPERIENCE WITH USING SUCH FEATURES AND FUNCITONALITY IN A 

PHYSICAL ENVIRONMENT MAY ALSO BE DIFFERENT. 

FEEDBACK.  If you give feedback about the technology features, 

functionality and/or concepts described in this Hands-on Lab to 

Microsoft, you give to Microsoft, without charge, the right to use, share 

and commercialize your feedback in any way and for any purpose.  You 

also give to third parties, without charge, any patent rights needed for 

their products, technologies and services to use or interface with any 

specific parts of a Microsoft software or service that includes the 

feedback.  You will not give feedback that is subject to a license that 

requires Microsoft to license its software or documentation to third 

parties because we include your feedback in them.  These rights survive 

this agreement. 

MICROSOFT CORPORATION HEREBY DISCLAIMS ALL WARRANTIES 

AND CONDITIONS WITH REGARD TO THE HANDS-ON LAB , 

INCLUDING ALL WARRANTIES AND CONDITIONS OF 

MERCHANTABILITY, WHETHER EXPRESS, IMPLIED OR STATUTORY, 

FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-

INFRINGEMENT.  MICROSOFT DOES NOT MAKE ANY ASSURANCES OR 

Terms of 
use  
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REPRESENTATIONS WITH REGARD TO THE ACCURACY OF THE 

RESULTS, OUTPUT THAT DERIVES FROM USE OF THE VIRTUAL LAB, OR 

SUITABILITY OF THE INFORMATION CONTAINED IN THE VIRTUAL LAB 

FOR ANY PURPOSE. 

DISCLAIMER 

This lab contains only a portion of new features and enhancements in 

Microsoft SQL Server 2014. Some of the features might change in 

future releases of the product. In this lab, you will learn about some, 

but not all, new features. 


